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AUTHOR’S NOTES

Last Free Version?

I know, I know. I keep saying the current release is going to be the last free version. Unfortunately, Web-O-Rama has a life of its own. As new features are added and existing features improved upon, I have felt it necessary to make new versions available. However…

…as an experiment in donationware, Web-O-Rama has been a failure. Despite nearly 150,000 visitors to my Web site over the past several years, I have been averaging fewer than two donations per month. This has not even paid for Microsoft’s yearly upgrades to Visual Basic, the programming language I use for Web-O-Rama. This may be the last free version (I have been threatening this for a long time). Without modest donations from frequent users, I can’t continue to give Web-O-Rama away. This does not mean, however, that I am discontinuing support for Web-O-Rama. I will continue to post updates to fix bugs and to improve performance, but I will most likely not be adding new features to the “Standard” (donationware) version.

An increase in the number of donations will encourage me to keep offering updated Standard versions of Web-O-Rama on my Web site. See Help Keep Web-O-Rama Free, below.

General Notes

Check my site, www.kevingunn.com, for updates. Please download the latest version or check the FAQ page before submitting a bug report. If for some reason you are unable to access my site, you can e-mail me (compguys@eudoramail.com) or send a hard-copy letter to Kevin Gunn, P.O. Box 442155, Lawrence  KS  66044-8933.

Please read all documentation before e-mailing me about bugs, installation problems, etc. Known or suspected problems are listed at the end of this file.

If you need to report a problem, particularly if you have purchased Web-O-Rama on CD, please e-mail me (compguys@eudoramail.com) rather than sending a hard-copy letter to my post-office box. I only check my post-office box every week or two, so you may end up stewing about the fact I am ignoring you, when in reality I just haven’t received your message. I usually respond to e-mail queries within 24 hours.

Suggestions, as long as they are not too flaky, are always welcome. Suggestions from people who have sent donations are given priority.

Copyright

Being classified as “Freeware” (or “Donationware”) does not mean that Web-O-Rama is public domain software or is not copyrighted. In order to distribute Web-O-Rama on CD or any other storage medium, you must get my permission in writing or by e-mail.

Windows 2000

Web-O-Rama runs successfully on Windows 2000. Because the installation updates certain Microsoft system files, the person installing Web-O-Rama must be logged in as a “Power User” or “Administrator.”

I have, however, discovered a few oddities while running Web-O-Rama on Windows 2000.
· The “Undo” feature on the “Edit” menu does not work. Currently being investigated. [Note: This applies to Web-O-Rama Pro Classic and Web-O-Rama Standard only. It does not affect the new Web-O-Rama Professional 8.]

· “Keyboard navigation indicators” (underscores, such as the line under the “P” on “Preferences” on the main menu indicating that you can press Alt+P to access the Preferences dialog) do not always appear. In Windows 2000, keyboard navigation indicators are hidden by default until you press the Alt key in most programs. To view keyboard navigation indicators, go to Control Panel ( Display ( Effects. Uncheck the box labeled, “Hide keyboard navigation indicators until I use the Alt key.”

· The Sound dialog behaves sluggishly after sound files are selected, particularly if files have unusually long names, such as “Bach’s Brandenburg Concerto No. 3.RMI.” RMI files will not play, although MDI and WAV files will. Currently being investigated.

All-new Web-O-Rama Professional 8 Available on CD

Web-O-Rama Professional 8 is now available. The new version includes a custom editing-window interface that features as-you-type syntax coloring, optional line numbers, unlimited undo/redo, a Web View tab that allows you to switch instantly between your HTML code and a code preview window, and much more. Additional information, along with screen shots, is available on The Computer Guys’ Web site at www.kevingunn.com. Use the order form (order.doc, included in the program folder) and send $35.00 to Kevin Gunn, P.O. Box 442155, Lawrence  KS  66044-8933, to receive a copy on CD. Please let me know by e-mail (compguys@eudoramail.com) that you have mailed a request so I will know to check my post-office box.

Web-O-Rama Pro Classic Available on CD

Web-O-Rama Pro Classic (formerly Web-O-Rama Professional) features the classic look of Web-O-Rama and includes a Web View tab that allows you to switch instantly between your HTML code and a code preview window. Screen shots are available on my Web site at www.kevingunn.com. Use the order form (order.doc, included in the program folder) and send $29.00 to Kevin Gunn, P.O. Box 442155, Lawrence  KS  66044-8933, for Web-O-Rama Pro Classic on CD. Please send an e-mail to compguys@eudoramail.com telling me you have mailed an order so I will know to check my post-office box. For $21.00, I will e-mail you the zipped weborama.exe file. The stand-alone weborama.exe file requires the latest full version of Web-O-Rama Standard and Internet Explorer 5 or higher to work properly.

Upgrades

There is no upgrade charge for people who have purchased earlier version of Web-O-Rama Professional. For $6.00, which covers the cost of the CD, mailer, and postage, I will send you the latest version on CD. Please use the order form (order.doc, included in the program folder) to request an upgrade.

Help Keep Web-O-Rama Free

If users in a financial position to do so would consider making modest donations to help with programming costs, I can continue to offer Web-O-Rama as donationware rather than traditional shareware (timed or limited to a certain number of uses without a registration key). Unfortunately, donations have been so sparse that it is doubtful I can keep offering Web-O-Rama on the honor system. Programming takes both time and money, neither of which I seem to have enough of these days. If you find the program useful, please consider making a small donation. I would be grateful. My mailing address is Kevin Gunn, P.O. Box 442155, Lawrence  KS  66044-8933. Even $1 would help. International money orders are more than welcome from overseas users. If you mail a donation, you might want to send me an e-mail at compguys@eudoramail.com letting me know. I do not check my post-office box very often due to the small number of donations.

Web-O-Rama Standard Now Available on Floppy Disks or CD

For those of you who would like a “hard copy” version of Web-O-Rama, the latest standard (donationware) version is now available on floppy disks or CD for a small charge (currently $9.00 for floppies or $19.00 for CD, including the cost of materials, postage, and handling). People making donations of $20.00 or more can, if they request it, receive a “free” copy on floppy disks or CD, but they will have to specifically ask for it (otherwise I will assume they do not want or need a copy). E-mail me (compguys@eudoramail.com) for additional details, or send a donation and a request to Kevin Gunn, P.O. Box 442155, Lawrence  KS  66044-8933. E-mail queries are normally answered within 24 hours; requests sent to my post-office box may take longer (you can always e-mail me if it is taking too long). International money orders accepted.

STANDARD DISCLAIMERS AND DISAVOWALS

Visual Basic is a benign programming language. Any time you install any program, however, you are taking a certain amount of risk. It is always a good idea to back up critical data before installing new software or hardware. If you have any installation concerns, check my Web site at www.kevingunn.com for the latest information before installing Web-O-Rama.

IMPORTANT INSTALLATION NOTES

Please read install.doc for important installation information!

Anyone who has any installation problems should download and install vbrun60sp3.exe, available from Microsoft’s FTP site, ftp://ftp.microsoft.com/Softlib/MSLFILES/vbrun60sp3.exe. vbrun60sp3.exe is a self-installing program. Put it in an empty folder and double-click on it to install. This updates several critical system files. You should also make sure you delete everything in the Windows \ Temp folder before installing any program.

PROGRAM NOTES

Web-O-Rama is an HTML editor written in Microsoft’s Visual Basic programming language. I would appreciate suggestions and bug reports from users. Check the FAQ page on my Web site first, www.kevingunn.com, for a description of known bugs and workarounds. I would advise downloading and installing the latest full version before e-mailing me about bugs, however. Exact wording of error messages (i.e., “Object variable or With block not set”) is extremely helpful.

If you have questions that are specific to Web-O-Rama, you are welcome to e-mail me, particularly if you have made a donation. However, if you are unfamiliar with HTML and need basic coding questions answered, try checking my Links page or performing an Internet search for “HTML.” There are many sites on the Web with in-depth information about HTML coding. In particular, I do not have the time or knowledge to answer detailed questions about forms, frames, or tables—all rather difficult at first. Although I have tried to make Web-O-Rama simple to use, a basic understanding of HTML is needed to use some of the more advanced features of Web-O-Rama.

BETA VERSIONS

Beta versions are pre-release versions and are provided “as are”; some have new features that have not been thoroughly tested. Always rename your previous version of weborama.exe before using a beta version. You may want to experiment on backup .htm files before working on production files.

NEWEST FEATURES

Please see history.doc for full documentation.

IMPORTANT STUFF

NT Compatibility

Version 4.0 added full NT compatibility (NT 4.0 only). Versions prior to 4.0 will not work with NT. NT displays some of the dialog buttons a little differently than Windows 95/98. Slight alignment problems do not affect functionality.

For Visual Basic Programmers Only

Programmers using Visual Basic should be aware that I am using Visual Basic 6 with Service Pack 5 installed. The setup program for Web-O-Rama will update some of the .ocx and .dll files on your system. If you are using an earlier version of Visual Basic and do not intend to upgrade in the near future, you may not want to install Web-O-Rama. It certainly will not harm your system, but you will be unable to make .exe-only files available and rely on users to download the standard runtime files elsewhere. This has ABSOLUTELY NO EFFECT on anyone except Visual Basic programmers.

Web-O-Rama is the product of thousands of hours of development, much of it through laborious trial and error. I will be happy to share some of the routines with other VB programmers (who have done the same for me), but I have put too much effort into the program to give away the source code in its entirety. I welcome, however, any kind of correspondence from programmers.   

SPECIAL INSTRUCTIONS

Web View

Select up to six browsers to display the HTML files you are working on the Preferences dialog (the first item under the “View” menu). Selecting “Default Browser” means that the browser you choose will start when you push the “Web View” toolbar button. The program will expect you to navigate to “netscape.exe” or “iexplore.exe” and then click on the .exe file, so it helps to know in advance where these files are located on your system. Netscape is normally in “Program Files \ Netscape \ Program.” Early versions of Internet Explorer may be located in “Program Files \ Plus!” Later versions should be in “Program Files \ Internet Explorer.” Note that the drop-down menu at the bottom of the navigation box allows you to select “netscape.exe,” “iexplore.exe,” or “All Files” to display in the window.

If you select “Autosave Files on Viewing,” the file you are working on will (obviously) be saved before the browser loads. If you do not, Web-O-Rama creates a temporary file (TMP0000.htm) for you to view. You will still be reminded to save your edited file before closing it.

If you already have a browser open and minimized, selecting “View in . . .  Browser” will start another instance of the browser. This is currently unavoidable as long as the browsers themselves are user-defined. Instead, save the file (there is a “Save” icon by the “Print” icon on the toolbar), then maximize and refresh the browser. I always close the browser when I am finished viewing a file, which also prevents the problem. If you have NOT selected “Autosave on Viewing,” you will have to close and restart your browser to see the changes (creates a new temporary file).

Displaying Graphics in Web Browser

If you have your images in a subfolder of the folder where your HTML files are located, you can specify, on several of the forms, a Root Folder. Choose the folder you are working in from the drop-down list and the path information to the images in the subfolders will be added. If you do not use the path information, graphics may not display correctly when viewed in a Web browser.

Using “Web-safe” Colors

You can choose to use non-dithered colors from the “Options” menu. This allows you to select colors using a limited set of hex values (216 total colors). These colors will display correctly in all Web browsers on systems capable of 256 colors or more. The Hex Value dialog now displays the RGB (red / green / blue) values for selected colors. You can use these values when creating graphics with other programs.

RESOURCES

The HTML Help files, wilbur.hlp, index.hlp, and css.hlp, are open source. Permission for me to use them unmodified in Web-O-Rama was confirmed 19 August 1999 by Liam Quinn of the Web Design Group.

I signed an ISV (Independent Software Vendor) license with Microsoft on 18 August 1999, allowing me to distribute Internet Explorer 5 or components of Internet Explorer 5 on CD with Web-O-Rama Professional.
Alan Simpson’s HTML Publishing Bible (IDG Books, 1996; now out of print, unfortunately) was my first book about HTML and was an invaluable resource. When creating the Help file for Web-O-Rama, I relied on the HTML Publishing Bible for help with several nearly incomprehensible issues (mostly having to do with commands for the alignment of figures with text). Alan kindly gave me permission to do this (e-mail, summer 1999); attribution is included in the Help file following any paraphrasing of Alan’s explanations.

Frank Boumphrey’s Style Sheets for HTML and XML (WROX, 1998) was helpful in giving me a basic understanding of style sheets before I embarked on creating the Style Sheet dialog.

The Wrox Ultimate HTML Reference Database, located at webdev.wrox.co.uk / reference / html4db, really is the final authority on HTML 4 specifications. I cross-checked all the compatibility information on the Tag List dialog for accuracy against their incredibly detailed database. Any errors, however, are mine. The Tag List itself was cobbled together from many different Web resources as well as my own trial-and-error experimentation; I did my best to avoid stepping on anyone’s copyrighted toes.

A year or so ago, a Visual Basic programmer, Geoff Hudik, e-mailed me and asked for some assistance in creating his own HTML editing program. Geoff asked permission to borrow a few ideas from Web-O-Rama, and I saw no reason not to let him … other Visual Basic programmers have done the same for me. He sent me the results, Web Mechanic, which has turned out to be a quality product with many great features. Geoff has made interesting use of Visual Basic’s Tree View control, showing an HTML tag list on the left side of the screen. Although I did not want to use his ideas byte for byte, I asked Geoff if he would mind if I implemented something similar to his tag list in Web-O-Rama. I had been tinkering along the same lines for a while, but had never thought of a good way to accomplish what I wanted. So, some of Web-O-Rama’s new features owe credit to Geoff and Web Mechanic. Thanks, Geoff!  

Web-O-Rama is an on-going team effort. I thank all of my patient on-line friends who have cheerfully looked over new versions and have offered suggestions and pointed out bugs. Thanks, as well, to users who have written with suggestions and been dragged into the project as beta testers. Special thanks to Paul Smith, Richard Allen Parks, and Karl Berger, who helped debug v. 6.71. D. Wall was extremely helpful with v. 7.02, and also discovered the incompatibility (fixed) between Web-O-Rama Professional and Internet Explorer 5.5. S. Ausland helped debug v. 7.08 and confirmed the problem with IE5.5.
Will Copeland, of Belfast, Ireland, contact me in the spring of 2001 with some suggestions for Web-O-Rama. I roped him into beta testing. He is directly or indirectly responsible for many improvements, including the Program Maintenance concept, and he kept after me until I solved the relative path riddle.

Extra special thanks to my wife, Karen, who continues to put up patiently with being a “computer widow.”

KNOWN, REPORTED, OR POTENTIAL PROBLEMS

· Netscape 6 may not open and display Web pages from within Web-O-Rama. I searched on line and discovered that this version of Netscape appears to lack DDE (dynamic document exchange) and does not respond consistently to shell commands. Previous beta versions of Netscape 6 seem to have worked with Web-O-Rama. At present, there is no workaround.

· The “Undo” feature on the “Edit” menu does not work in Windows 2000.
· If you are trying to save a file to a LAN server (I:\\, for example), you may get an “Error saving file …” message. The file will save successfully under most circumstances; the error message can then be ignored.

· I installed Web-O-Rama on my NT machine, which had an inexpensive graphics card, and Web-O-Rama locked up when I tried to run it. I changed the number of displayed colors (Control Panel > Display > Settings) from “True Color” to “High Color.” Web-O-Rama ran fine after that. The problem turned out to be with the splash screen. If you set the number of displayed colors lower and disable the splash screen using Web-O-Rama’s Preferences dialog, you can then set the number of displayed colors back to the original setting. This appears to be a problem with certain older graphics cards.

A small program (15 KB), Web-O-Splash, is available on my Web site (www.kevingunn.com) that will allow you to disable the splash screen from outside Web-O-Rama.

· Animated .gif images will not appear animated when opened in the Image dialog. This is currently a limitation of Visual Basic and not a “bug” per se.

· One user reported getting a General Protection Fault when trying to view images using the Image dialog. Installing vbrun60sp3.exe (see above) fixed the problem. Please make sure you install this Microsoft update before sending me bug reports! You also might try changing the number of screen colors your computer displays (Control Panel > Display > Settings). GPFs can often be traced to problems with graphics drivers. Make sure you have the latest for your card.

· Scrolling very quickly through a list of image files on the “Quick View” tab of the Image dialog may cause the program to crash. As with nearly any program, it is possible to crash Web-O-Rama by exceeding software and hardware limitations.

· Several (very few!) users have reported problems installing Web-O-Rama from the CD. Usually, these problems take the form of odd error messages, such as files not being found. Please read install.doc thoroughly before installing Web-O-Rama to avoid potential installation issues. If you have purchased Web-O-Rama on CD, you are entitled to a full refund if you cannot install the program. Please contact me (compguys@eudoramail.com, or post office box address, below) for details. Some very old CD players may have trouble reading “home-made” CDs. If you have difficulties, try opening and closing the CD player repeatedly with the Web-O-Rama disk in it. This usually works on my older computer.

· One user has reported getting an error message about Explorer (the file-manager interface, not Internet Explorer) crashing kernel32.dll when trying to view a Web page by pushing the Default Browser button when the default browser was set up in Web-O-Rama to be Internet Explorer 4. I have not been able to duplicate the error. If you have installed other programs since the installation of Web-O-Rama, you might try reinstalling Web-O-Rama. Make sure you have a recent copy of Internet Explorer on your system (version 5, if possible).

· I performed a long search and replace for odd word-processing codes (in a text file that had been created in Wordstar) and Web-O-Rama locked up. I had previously replaced two spaces with one space and the program reported 642 replacements, so the number of items does not seem to cause the problem. I would suggest saving files before doing an extensive search and replace (always a good idea, anyway).

· If, for some reason, Web-O-Rama starts displaying error messages when you attempt to open it, try reinstalling Web-O-Rama. As noted above, installing certain programs after installing Web-O-Rama may make Web-O-Rama inoperable. Problems with Web-O-Rama can almost always be traced to a system problem rather than a problem with the program itself. You can also use regedit.exe (the Registry editor) to search for “weborama” and delete the entire “weborama” directory key (but be careful when editing the Registry!). It is possible that if you have set up Web-O-Rama to start in a specific folder and then deleted or renamed the folder, you will have problems (although the built-in error handling should take care of this under normal circumstances). The only thing deleting the Registry key will do is erase the configuration options you have chosen in Web-O-Rama.

· The Color Tags option will NOT work on any file containing unpaired “<” and “>” (such as JavaScript using “>=”). The program will not crash, but it will not color all the tags. If you are NOT using JavaScript and still cannot get the tags to color correctly in a particular file, you probably have errors in your HTML code. Although the Color Tags option was not intended to be a diagnostic tool, it can be used as a quick check of your HTML code.

___

Kevin Gunn

P.O. Box 442155

Lawrence  KS  66044-8933

E-mail: compguys@eudoramail.com

Home page: www.kevingunn.com
